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ﬁ' A
Electric current! Danger to life!

Installation, commissioning and maintenance work
must be carried out by qualified personnel only.

Lebensgefahr durch elektrischen Strom!

Arbeiten bzw. Montage an diesem Produkt darf
nur von Elektrofachkraften und elektrotechnisch
unterwiesenen Personen ausgefiihrt werden.

@ Tension électrique dangereuse!

L'installation de I'appareil, ainsi que tous les travaux
effectués sur celui-ci, doivent étre réalisés par un
électricien qualifié ou par un personnel spécialement
formé.

iCorriente eléctrica! jPeligro de muerte!

La instalacion del dispositivo, asi como todos

los trabajos en él, deben ser realizados por un
electricista calificado o por personal especialmente
capacitado.

(@ Tensione elettrica: Pericolo di morte!

L'installazione e il lavoro sul dispositivo devono
essere effettuati da un elettricista qualificato o da
personale specializzato.

@ fiflk
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@ 3nekTpuyeckmii Tok! OnacHo Ans xusHm!

YcTaHoBKa M aKcnnyatauus yCTponcTBa AOMKHbI
BbINOSHATLCA KBANUULMPOBAHHBLIM 3IEKTPUKOM UNn
cneuuanbHo 06y4YEHHbIM NEPCOHANOM.

@D Levensgevaar door elektrische stroom!

Installatie van het apparaat en alle werkzaamheden
eraan, mogen uitsluitend door een gekwalificeerd
elektricien of speciaal opgeleid vakpersoneel worden
uitgevoerd.

Livsfare pa grund af elektrisk strom!

Arbejde i forbindelse med installation, opstart
ogvedligehold ma kun udferes af kvalificeret
personale.

Mpocoxn, kivBuvog nAekTpotrAngiag!

H eykataaTaaon, ekkivnon kal ouvtripnon 8a Trpéel
Va TIPQYHATOTIOIEITAI POVO ATTO EGEIBIKEUNEVO
TIPOCWTTIKG.

@D Perigo de vida devido a corrente eléctrical

A instalagéo do dispositivo, bem como todos os
trabalhos devem ser realizados por um eletricista
qualificado ou por pessoal especialmente formado.
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(&Y Livsfara genom elektrisk strém!

Installation, idrifttagande och underhallsarbete far
endast utféras av behorig personal.

(@ Hengenvaarallinen jinnite!

Laitteen asennus ja kayttd ainoastaan sahkbasentajan
tai siihen perehdytetyn henkilon toimesta.

(©® Nebezpeéi trazu elektrickym proudem!

Instalace zafizeni a veSkeré prace na ném musi byt
provedeny kvalifikovanym elektrikafem nebo specialné
vySkolenym personalem.

Eluohtlik! Elektrildgioht!

Paigaldus-, kasutus- ja hooldustoid peab labi viima
ainult kvalifitseeritud personal.

(U Eletveszély az elektromos aram révén!

Az eszkoz felszerelését, valamint az ehhez
kapcsol6do 6sszes munkat szakképzett
villanyszerelével vagy szakképzett személyzetnek kell
elvégeznie.

(W) Elektriska strava apdraud dzivibu!

Uzstadisana, nodoSana ekspluatacija un apkopes
darbi javeic tikai kvalifictam personalam.

(D Pavojus gyvybei dél elektros srovés!

Jrengimo, paleidimo ir techninés priezitros darbus turi
atlikti tik kvalifikuotas personalas.

@D Porazenie pradem elektrycznym stanowi
zagrozenie dla zycia!

Instalacja urzadzenia, jak réwniez prace nad nim,
muszg by¢ wykonywane przez wykwalifikowanego
elektryka lub specjalnie wyszkolony personel.

@D Zivijenjska nevarnost zaradi elektriénega
toka!

Dela montaze, zagona in vzdrzevanja morajo izvajati
samo usposobljeno osebje.

@K Nebezpeéenstvo ohrozenia Zivota
elektrickym pradom!

InStalacia pristroja, ako aj vSetky prace na riom musia
byt vykonané kvalifikovanym elektrotechnikom alebo
Specialne vyskolenym personalom.

(B9 OnacHOCT 3a XMBOTa OT eNeKTPUIECKM TOK!

V]HCTaJ‘MpaHeTO Ha yCTpOIZCTBOTO, KaKTO 1 BCSAKa
paboTta no Hero, Tpsi6Ba Aa 6bae M3BbPLUBAHO OT
KBaJ‘IMd)IALLMpaH ereKTpPoTeXHNK nnn oT cneunanHo
o6y4eH nepcoHan.
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Atentie! Pericol electric!

Montajul si lucrul cu acest aparat trebuie facute
numai de un electrician calificat sau de personal
tehnic specializat.

(D Opasnost po zivot uslijed elektriéne struje!

Radove ugradnje, pustanja u pogon i odrzavanja
mora vrsiti samo kvalificirano osoblje.

@ Elektrik akimi! Hayati tehlike!

Bu uriiniin galistiriimasi veya kurulumu sadece
elektroteknik egitimleri almis olan ehliyetli elektrikgiler
ve kisiler tarafindan yapilmalidir.

(8D EnextpuuHa cTpyja! OnacHocT no xusot!

ApGenTeH 638. MoHTaxa n anecem MNpoaykT aapd
of EnektpodauxkpadTeH yHA, enekTpoTEeLXHUCLIX
yHTepBueceHeH NepcoHeH aycredyxpT BepaeH.

Elektrisk strom! Livsfare!

Installasjon av enheten, samt arbeid pa den, skal kun
utfares av kvalifisert personell, eller av de som er
spesielt oppleert til dette arbeidet.

@Y Enektpuunuit ctpym! HeGesneuHo ans
Kutta!

BcTaHoBneHHs1 NpucTpoto, Tak camo, siK i poboTta
3 HUM, NMOBWHHI BUKOHYBaTUCh KBaslidhikoBaHUM
€neKTPUKOM abo NepcoHarom, Lo NPOLLOB
crnevujianbHy NigroToBKy.
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1. Abbreviations

xDC Diagnose controller

RF Radio frequency

2. Accessing your Diagnose controller from your PC

The Diagnose Controller can be directly accessed from your computer by using the web browser on your computer.
In order to access the xDC, it is important that the PC and your xDC be placed in the same network.

S |' HDMI/USB

LAN PE |
Lagton 5 \
i
e |
i \\‘\ -"Irll —_-_-—::"
? “LAN (Cat5i6a) —1— 1 USB
/ )
7 f |

ee e e aa

LR R Q@

21 Physical network setup
1. Connect your xDC to your computer network, by using an Ethernet network cable.

2. To obtain the IP address for accessing the xDC web server through your web browser, then use IP
address assigned by your IT team or follow the instruction set 2.2 for using your own router.

3. In case of missing DHCP server (timeout for searching: 10min), a fix IP address (169.254.1.15) is
available for the Diagnose controller.

4. When you have the IP address then move to Instruction set 2.3.
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2.2 Obtaining your IP address via your router
1. Ensure that both your computer and xDC are connected to the same router.

2. Read the instruction manual of your router, or check the type label of the router in order to access the
router directly.

To access the router directly you will need the following information:
e The Router IP address that you need to type directly into your web browser.

e The default username and password that you need to login into the Router.

3. Upon accessing the router web page, navigate to the DHCP clients list to find out the assigned IP
address for the xDC.

Status

Guick Setup ARP List
WPS
Network

[[8] MAC Addrass IP Address Status Configura
Wireless
DHCP I 1 00-01-C0-26-63-25 182.168.0.100 I Unbound Load Delete
Forsarding ? AC-16-2D-57-EC-49 192.168.0.101 Unbound Load Delete
Security
Parantal Contral Bind All M _F f I__

Aceess Contral
Advanced Routlng

Bandwidth Control
TP & MAC Binding

= Binding Settings

2.3 Accessing your Diagnose controller

2.3.1 Once you have the correct IP address for the xDC, type it into your web browser.

b = = = = =

TL-MR2ZH) ﬂ‘jrﬂ Diagnos Visuakzation - Site_. % |'~_+

& 1ansen00 4 | B~ cosgte o
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2.3.2 When you arrive to the Login screen, enter the following details for Login:

In case of first login choose Administrator as per default password: eaton_diagnose
Full access for uploading.
XML-file and doing configuration / sensor arrangement etc.

Viewer mode can be entered if configuration was successfully uploaded before / 2nd login after configuration
limited access just for visualization the running application on an HMI.

LOGIN
User: | Administrator v |
Password: ‘---.-ccnn..-i- ‘
 Login |

2.3.3 Correct entry of login details will take to the Site Configuration page — click on the arrow bring you back to the
login screen. Non-admins cannot access the settings page and cannot change any settings of the diagnose
controller.

E-T-N

FPowering Businass Wonidwide

Configuration #r E

DIAGNOSE CONTROLLER SETTINGS

Here you can modify all configuration seings rélated 10 the diagnose controllér hardware or system setings
Please click on the heading 1o @xpand hese setings

NETWORK SETTINGS

Hare you can modify IP address setlings, including time sener and SMTP server seltings.
Please click on the heading o epand these selings.

SITE CONFIGURATION
Mew Configuration

o There is currently no configuration loaded.

Upload of Eaton Configurator file: | Durchsuchen. | Keine Datei ausgewshit

Restore site configuration Diurchsuchen_ | keine Datei ausgewshit

Administralp

H configuration #
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3. Updating your Diagnose controller to the latest firmware

3.1 You can update your xDC to the latest firmware version:

Download the latest firmware version from Eaton Download Center: ftp://ftp.moeller.net/AUTOMATION/
DOWNLOAD/XNT/XNT-CTRL-00_01. Copy all file from diagnose_offline_update_x-y-z.zip on empty, formatted
USB Stick. Insert USB stick in USB port of Diagnose Controller. The bottom configuration icon changes to red and
is displayed with the red text “update available” next to it. Open Configuration page (or reload it, if already opened).

3.2 Press the “Update Software” button.

Costrobe Brrealany: 12,1767
1.5.0 Ll spdade TP AT

E:T-N

Fovvprrig B Hebrlhuede

DIAGNOSE CONTROLLER SETTINGS
Zoftware Update

There is a software update available: 1.8.0 = 2.0.0
Pleate update he soltware usng the bulton below The update will take a lew mnules

Update Software

3.3 Upon direction to the Waiting for Software Update, please allow 15 minutes to pass while waiting for the device to
reboot and automatically redirect back to the site configuration page.

Confraler raitanp- 171073
180 Lasnt ipaena- 121747

E-T-N

Frvaring Buaimedy Wordds

DIAGNOSE CONTROLLER SETTINGS
Software Update

o There is a soffvare update availabie: 1.8.0 > 2.0.0
Please upiate the soffmire usng the bullon Deiow The update wil Laog & few memules

Uplate Saltwiare

Software update staried. Please be patient.

3.4  After about 15 minutes, you will be re-directed to the Site Configuration page and the Software Update section will
no longer be displayed. This section will only be shown when another update is available.
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4. Diagnose controller settings

41 Time settings

Click on “Diagnose controller settings”- Button, insert current date and time and click on “Change Time"- button.

DIAGNOSE CONTROLLER SETTINGS

Software Update
¥ou can check whether there is a SW update available. Please make sure to have this Diagnose controller connected to the Internet before performing this
check
Check for SW Update
Time Settings
The date and time seftings for the Diagnose controller are automatically retrieved by a network time server. However, if the coniroller is not connecled to
public internet, the automatic time synchronization may not be possible. In this case you can manually adapt the time settings here.
Timezone: Europe/Vienna v
Current date: 10/20/20210

Currenttime: | -—-:-—-:-—- --

| Change Time

4.2 Change password

Click on “Diagnose controller settings”- button.

For change the Login-Password fill in the current password, choose Administrator or Viewer, enter the new
password and repeat it. Default for Viewer is no password (auto-login) Press “Change Password” button.

DIAGNOSE CONTROLLER SETTINGS

Software Update
You can check whether there is a SW update available. Please make sure to have this Diagnose controlier connected to the internet before performing this
check.

Check for SW Update
Time Settings
The date ana time settings for the Diagnose contraller are automatically retrieved by a network time server. However, if the controlier is not connected to
public internet, the automatic time synchronization may not be possible. In this case you can manually adapt the time sattings here.

Timezone Europe/Vienna v

Current date: 10/20/20210

Currenttime: | -—:--:-- --

Change Time

Change Password

You can change the passwort for the administrator or for the viewer account. The web side can be viewed without login if the password for the viewer user
is left empty. To be able 1o change a passwort also the current administrator password needs 1o be enterad.

The passwort of the administrator account requires minimal & characters, including three of upper case, lower case, digits and special characters

Current administrator password: 1.-.........-... |

@ Administrator

Account to change password for
" O Viewer

New password:

New password repeated:

Change Password
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Password length should be minimum 6 characters and must meet at least 3 out of the following 4 complexity rules:

e at least 1 uppercase character (A-Z)

* at w character (a-z)

* at least 1 digit (0-9)

e at least 1 special character (punctuation)

4.3 IP settings
Click on “Network Settings”- button.

NETWORK SETTINGS

IP Settings
Mode DHCP v
NTP server 1: pool_ntporg
NTP server 2: er“ pool.ntp.org

Save IP Settings

Standard mode is DHCP — IP-address will create from the Ethernet network If you want to set fix IP-address, change to
mode “Static” and fill in the fields and save the IP settings.

NETWORK SETTINGS
IP Settings
IP Address: | 192.168.0.17|
Subnet mask: | 255.255.255.0|
Mode: i =
| Static v | | Default gateway: | 192.168.0.1|

DNS nameserver: 8.8.8.8|

NTP server 1: |p|]0|_ntp_|]rg |

NTP server 2: |e.g. pool.ntp.org |

| Save IP Settings |

Fill in NTP server if needed.

4.4 Https certificate

Click on "Network Settings”- button.
An externally signed certificate can be upload.

NETWORK SETTINGS
IP Settings
Mode: | DHCP ~ |

NTP server 1 | pool.ntp.org |

NTP server 2: |e,g, pool.ntp.org

| Save IP Setu'ngs|

Hitps Certificate

For security reasons, the Diagnose controller is only accessible via TLS. Per default it uses self-signed certificates, which are automatically generated.
Alternatively you may upload an externally signed certificate here, that matches your controller domain.

Certificate file: | Browse... | No file selected.

Key file: | Browse... | No file selected.

|ypluad Certificate |
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45 Email settings

Click on “Network Settings”- button.

NETWORK SETTINGS
IP Settings
Mode: | DHCP ~

NTP server 1: _'pool.nl:p.org

NTP server 2: :r-_(_]_ pool.ntp.org
| Save IP Settings
Https Certificate

For security reasons, the Diagnose controller is only accessible via TLS. Per default it uses self-signed certificates, which are automatically generated.
Alternatively you may upload an externally signed certificate here, that matches your controlier domain.

Certificate file: | Browse... | No file selected.
Key file: Browse...  No file selected.
| Upload Certificate |

Email Settings

Please configure an Email provider, such that the Diagnose controller is able to send emails, i.e. on alarm events.

SMTP Hostname: !-e.c_q. mail.yourdomain.com
Username: '

Password: |o...ooo.oo-ooo

From address :e_c_z. diagnose@eaton.com

To address ;e.g. yourname@yourdomain.com
TLS Security: | Yes v

| Save Email Settings || Save and Send Test Email

Fill in the settings for the e-mail. Test e-mail could be send.
Alarms are sent by e-mail to specified address(es). Language of e-mail is set when e-mail settings are saved: if
preferred language of browser is set to german, e-mails are sent in german; otherwise e-mails are sent in English.
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5. Configuring your Diagnose controller to visualize your low voltage site setup

The xDC requires an XML file export of your site configuration from the Eaton Configurator xEnergy tool. Follow the
instruction set 5.1. to obtain the XML file from the Eaton Configurator xEnergy tool. When you have this XML file
available on your PC then proceed to the next instruction set 5.2.

5.1

Exporting the XML file from Eaton configurator

1. Once you have the completed configuration of your xEnergy Site, using the Eaton Configurator xEnergy tool,
navigate to the menus: File > Export.

i '&m e l‘g‘ﬂmul [ Tl Gty etock sohver

Edit

= Argcii
B Hew ]' ¥oow p 4 0 |
Expart... = = P L iy Copy | s Dupbcate
[ Send hile by mail.. i Timsey <k '::I'::

XF - Fived Motnbed Modules [ ] owers . [irst®_iotnFEGD _Jorsiper
= = *|oa e with Desgros
b « Bl Convibwition baard
. e b 46501

srouneg[] sunedg] sascod §

2. When the Export popup window comes up, ensure that the Format setting is XML project description.

Under Filename, use th@ Button to select filepath, and to enter the name that would like the XML file to be
saved under.
Finally click the Export button to carry out the export.

Project Site with Diagnos - Eaton Configurator xEnergy

Material Master data Tools

Project Help

E! Save as...
f= Open T
i Stribution - Busbar Back) ® & Structure | % Preview | E Shopping cart | E Cutting stock solver ?
+ - | Ansicht | Al 3
MNew B ]
! x Cut 0 E—_
: - 7 Delets urther
B3 Sendfile by mail... _ By Insert details §
8 b i Edit 5
¥E - Fixed Mounted Modules Element | InstID | Location | EQID | Description |j|
b| o4 Site with Diagnos g
.4 [ Distribution board g
; Main busbar +H501 i

ket s =
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3. Once the export is complete and successful, the Transfer project popup window should come up with the
information that “The project has been exported successfully”. Continue to instruction set 4.2 to continue
configuring the visualization your xDC.

_&EHM ® o |'i:ﬂ-'-;ww- [ﬂn;mmr-i-'dmw

arachy |

o T [

€ = P J | Upcopy | = Dot x 'g
i 1 ! dntai

Edit
[ Clamens et iy v BR[| Descrigtion
[ — : v 2
+ [H Desmrninon hoad

— I i b it
Expart
| ML pRodect descriptan

Phcme
| bmirsE]

5.2 Uploading the Eaton Configurator file and place sensors

5.2.1 Click on “Site Configuration” button.
5.2.2 Click the Browse button to find the Eaton Configurator XML file export to upload.
Selected the file and it will be upload.

Configuration ﬂ' H.

DIAGNOSE CONTROLLER SETTINGS

Here yous can modity all configuration settings reiated 1o the diagnose Conbroler Rardeane or sysiem sefings.
Pieada cick on The hiading 10 expand (Fese setlings.

NETWORK SETTINGS

Hizre yois can modily 1P acdress setings. including time server and SMTP sener setings
Pt 90K 0N (i REamng 10 espand (hise seftings

SITE CONFIGURATION
New Configuration

o Thete is cutrenlly ne configuralion laaded

Upiou af Eaton Confiqurstor e | Browse... | o file selected.
Besions ste configuraton Browse., | Ho file selected.

1

N

Diagnose Controller Quick Installation Manual September 2022 www.eaton.com



5.2.3 Once the xDC has completed the upload process, you will be re-directed to the Distribution Board Site

Overview Page. On this page you can see all the sections visualized.

Controler pepmiany #4323

x2.1 Lot upetate B 5447
E;T-N SYSTEM STATE: MISSING DATA
Flanerang Sodeens Wikl
BEB_XP IZMX16_Top_3p_Inc_Bottom XF_3p - Site View ] H

BEBE_XP_IZMX16_TOP_3P_INC_BOTTOM_XF_3P

Power section 1 Festeinbau Abgangsleia 1

oria 1o
P

ADovE graphic Shows 2 sechons which ane configured for your sile. You Can CiCk on @ section B pel @ detaked veorw Tof @ Singie sochion. Tne et at
e bottom of each section shows he number of equipped sensors and ine number of possible sensor postions

If & wa OF gler] phivais wihin & sechon his g ated By B0 O 0 Fedd D kgproaund €okor
o

Almansirains L’ ConsguT e #

5.2.4 Hovering over a section with your mouse highlights the section for selection.
Clicking on section will direct to the Section View.
BEB_XP IZMX1E6 Top 3p Inc_Bottom XF_3p - Site View ﬂ' “

EEE_XP _1ZMX16_TOP_3iP_INC_BOTTOM_XF_3P

Power section 1 Festeinbau Abgangsieid 1

LIRS 110
I IS TGS ST
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5.2.5 The Section View allows you to view all the recommended sensor positions for that particular section.

E;T." St Wiiw = Sechion View SYSTEM STATE: MISSING DATA,
Prnenng Suas Werkbde

BEBB XP IZMX18 Top_ 3p Inc Bottom XF_3p - Section View

f o

SECTION POWER SECTION 1

Side

Front

TR rRrrr

Daks shawn: (@) Ternperature () Casrent

( Mbove graphic shownd the sechion Power $ection 1 On the lefl you See the Side view of the section and an the rght the frant vew If there afe Sensors éqaped
“ behind each ofher, the view shows all diferent 7-planes

You may chck on a Sermod (o See the detsls of The sensor asSgred 1o the bus bar ¥ no sensor is assighed the ink yiskds (he Stnsor assignment configuration
Page:

5.2.6 Hovering over a sensor area highlights the selected sensor. Clicking on the sensor will direct you to the Sensor
page for that particular sensor location.

Side Back Frant

CEd , ENEE

Ll
C_EN_B BN N
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5.2.7 To assign a sensor, select it from the dropdown menu if already detected by the system. Otherwise manually enter
the sensor number in the Serial Number entry box. You can add any comments regarding the sensor in the
comment box. Upon completion selected the “Assign Sensor” button in order to assign the sensor to that position.

'
E.r. N Site View > Section View > Sensor Assignment SYSTEM STATE: MISSING DATA
Powvaring Business Wondwade
BEB XP IZMX16 Top_3p_Inc_Bottom XF 3p - Sensor Assignment fr l.’
SECTION POSITION

This is the assignment of the temperature sensor for,

Section name: P
Sensor position:  Main Busbar Top / L1

7 sechon 1

Create a new Sensor Position

NEW SENSOR ASSIGNMENT
Type: Busbar | Assign Sensor |
Serial number: | other v | | =

F On thes page you Can assgn a Sensor 1o the grven Section bus bar of creale a new sensor postion for freely placeable sensors

The currently modified sensor is indicated with a red border in the graph on the nght. By clcking on another sensor m the sechon
graph you can peronm the assignment for a different postion.

After assignment of a sensor the next unassigned sensor is automatically selected P AT T

It you want to assign a sensor which is not chckable due to overlaps, please swich to the section view (link near “Section
name”) and chick there the accarding sensor

5.2.8 Fill in correct number of digits for serials of sensors — otherwise warning field informs you:
Busbar: 5 digits
Ambient: 7 digits

& 192,168,101

Serial number not vatid. Please enter 5 (Busbar or 7 (xComiort] digits

| Don't altow 19216810101 0 prompt you sgan
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5.2.9 Assignment of the sensor takes the user to the assignment of the next unassigned sensor of the current section.
After all sensors of current section are assigned, it brings you back to the Section View. If the sensor has not yet
sent a signal to the xDC then a question mark will be displayed in the box, otherwise the sensor temperature
reading will be displayed in the box. The sensor assignment can be continued in the same fashion for all sensors.

E;T.N Site Viaw » Section View > Sensor Assigrment SYSTEM STATE: OK

Fimvnnng Busnits Wi

BEB XP_1ZMX16 Top_3p Inc_Bottom MNF_3p - Sensor Ass

SECTION POSITION

This 5 the Estgrmenl of the lemperatune sensad lor

Section nama:
Sensor posiion;  Main Busbar Top | L2

Create a new Sensor Position

MNEW SENSOR ASSIGNMENT

Type: Bushar Assign Sensor
Serial number: | other + Z

0 fhes page you Can S5UGn 8 Senscd io he given sechon Bus bar of ciese & rew Sshsor pasiicn for fresly placeable ssnhsors

The cumently moddfied sensor i indicaled with & red bordes in e graoh on the night. By chcking on another Sensor in the section
Graph you can perfurm the assagrment for  diferent position

Afer psmgnment of & SeTHor B ndud Unassgned SEnSor & miomaticaly selecied ///’fr’///’f

I you wan 1o assign & Sensor whech 5 nof Chckable due by overlaps, please Switch 1o the sechon view (ink near ~Section
rame” | and chok thene the accondng sensor

5.2.10 To assign an ambient sensor, click on the sensor on the top of section view. Manually enter the sensor number in
the serial number entry box and select channel. You can add any comments regarding the sensor in the comment
box. Upon completion selected the “Assign Sensor” button in order to assign the sensor to that position.

i . B, :
E-T.N Site Wiew = Section View > Sensor Assignment SYSTEM STATE: OK

Fownnng Susaness Wonkhiede

BEB XP IZMX1& Top 3p_Inc Bottom XF 3p . Sensor Azsignment

o

SECTION POSITION

rm&wmﬂﬂmmutmrﬂ

Section name; Pover St 1
Sansor position:  Amberd Secton |

Create a new Sensor Position

NEW SENSOR ASSIGNMENT

O Bhiss page you &N SSEIgh @ SEnsor 10 The ghen Ssection bus bar of creste @ new Sendor position for freely placesble sensons

Th currently rodified Sendor i s ated with @ red border in e graph on the nght. By cholang on another sengor in the Section
graph you can pefanm e assagnment for & diferenl posdion ///,f///f

After assignmaend of a sensor the nest unassigned sensor i atomatically selecbed

I o w10 @5sgn A sensol wiech is not chckable due to overlaps, please swilch to the section wew (ink near “Sechon name™) and Chck tere the accordng
HENEOT
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5.2.11 It is the ability to set own thresholds for warning and alarms. Click off the “Default” checkbox and enter the values.

E;T.N Soldy Ve > Sacton Viens = SRsor Ms.lgnn'mn! SYSTEM STATE. OK

Fowening Sewness bridwis

BBE _XP IZMX16 Top 3p_Inc_Bottom XF 3p - Sensor Assignment

SECTION POSITION

Thus o Bhe assagramend ol the lemperalune senzof for

Sensor posithon;  Main Bushar Top /LY

Create a new Sensor Position

CURRENT SENSOR ASSIGNMENT

Type: Blushar
Serial number: 1

SENSOR SETTINGS
Comment:
Custom temperature warning [CE 90 2 O oetwa P
Cuistom temperaturs alsrm [C]: 100 .
Custom current limit [4]: 3400 : [J Detma 37500
Save Settings |

O this pages i o drsagn @ Serrson 1o The grem SeCUon birs bar of Creste a Pew Sensor postion for freely placealie sensars

5.2.12 To create a new sensor position choose any sensor position. After that click on “Create a new Sensor Position”
and select the x and y-Position in % - press “Create Position”.

11 - .
E- .N B View = Soctan Yk = Sonsor ASsipnman 5‘{'5?&_1_5“\1’52 oK

Povwening Susnesy ety

BB XP IZMX16 Top 3p Inc Bottom MF 3p - Sensor Assignmant e d ey

SECTION POSITION

This is the scogrement of the emparatune sensar for:

SeCTon REme
Sansor positon:  Main Buskar Top /12

Create a now Sansor Position
xPosition (%) |50 E
Croate Position
wPosition [%]: |50 g
HEW SENSOR ASSIGNMENT
Serial number: | other ~ || -

O s page you Can asSign & Sensor 1o e green Secton bus bar of creale & new sensor posiion for Inesly plac sable sensors.
LS

The curently rmodified sersad i ndicated with 8 red bocder in the graph on the nght. By clitkng on another Sensor in the Sachon
graph you can perform the assgnment fof & difesent poston

Afler assignment of & Sensor (he e unasSigred Sensor iS aubimalic Aty Seleched

¥ you wanl o ¥5gn & sensol which is nol chokasble due lo overlaps, please Sach 1o Bhe Secton wew (Ink near “Secton name") and chck thers the accoiding
SETSOF
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You can modify or remove the new position.

SECTICN POSITION
This i= the assignment of the tempearature sensor for

Section name; P sl
Sensor position:  Flesible Sensor / X50. Y50

Modify this Sensor Position

s-Position [%]: |50 -

y-Pesition [%): |50 .

Create a new Sensor Position

5.2.13 You can remove the sensor or replace it with other sensor.

BBB_XPF IZMX16_Top_3p_Inc_Bottom_XF_3p - Sensor Assignment

SECTION POSITION

This & [he assignment of the lemperalure sensof for

Section name: Power aeclion 1
Sensor position:  Connéclon Top /LY

Create 3 new Sensor Fosition

CURRENT SENSOR ASSIGNMENT

Type: Bushar
Sarial number: G5535

5.2.14 Table view of all sensors
On the “Site View" by clicking on the link will bring you to the list of all sensors.

BBEE NP IZMX16 Top 3p Inc Bottom XF 3p - Site View

BEB_XP IZMX16_TOP 3P _INC_BOTTOM_XF_3P

Power section 1 Festeinbau Abgangsieid 1

o113 110
LA FFA LSS s
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By clicking on the head of the table, you can sort the values. Clicking on the Field will bring you the Section View;
Clicking on the Serial number will bring you to the Sensor View.

i l
E. ." Site View = Sensor Tabke

BEB_XP _IZMX16_Top_3p_Inc_Bottom XF_3p - Sanzor Table

SYSTEM STATE: OK

SENSOR TAEBLE

State ¢ Temperature 2 | Current

Last Data 2 | Serial *

Ok, 25T P Aribiernd Seclion - 2024-10-20 10.07.33

L= i = B il Gonnectar Top L3 A 020 TN E 4D EH
O 257 Flexble Sensor X350, ¥30  2021-10-20 100735 [
O J22°c Main Gusbar Top L1 2021-10-20 10:08:42

5.2.15 Clicking on an assigned sensor location from the Section View page will direct you to the Sensor View. On this
page you can view the sensor specific data, including the all the current day values, a 4 weeks graph
(1 temperature value all 10min) and trend values for the past 180 days.

SENSOR DATA

st ——

SEN3SOR FROFPERTIES

Sensor Type: Busbui

Last data from:  2029.10-20 9 1731 Serial number G554
Temparature: W5"C
Current; 1054

SENSOR ASSIGNMENT
Signal strength: <= .71 abm P Prws B 4 3
Show furthaer detsils

Above you Can See all The detass of the selcled IEMperalre Sensor S IS clmen] Gaa vaisss Below you See e Mnamum, Sverags and
it walue of st

By tickng on the Sechon name at Sensor sssgmmenl 3 the ngfit you Can negonigune e Curment Sensor assignment.

TODAY'S VALUES

Yo

‘ ‘ 2
‘ 1A
L Bl Teegacicars |
O Currer g ¥
»C A
2 ™ =T P o a L)
4 WEEK VALUES
L o 2ad &
"
|
L
b
n s
| RS Eh-
-
a
T T [TT [rET 1518

User scroll whesd t0 200m and orag 1o pan
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TEMPERATURE LONG-TERM VALUES

.

S

CURRENT LONG-TERM VALUES

= ]

The sensor data shows the last time, when the sensor send a date; the temperature of the copper; the sensor signal
strength.

SENSOR DATA SENSOR PROPERTIES
State: . " Sensor Type: Busbar
Last data from: 2021-10-20 917221 Serial number: 65535
Temperature: 39.5°C
Current: 105 A SENSOR ASSIGNMENT
Signal strength: = -71dBm Section Power section 1/ Main Busbar Bottom / L1

Show further details

On further details you see: the battery voltage of the ambient sensor or the generated voltage depends on the current; the
PCB-Temperature; the maximum allow current (if it is a current sensor).

SENSOR DATA

State: _ OK. _
Last data from: 2021-10-20 9:36:13
Temperature: 358 °C

Current: 104 A

Signal strength: — -71.dBm
Sensor voltage: 5.5V / good
PCB-Temperature: 259°C

Maximum allowed current: 165 A
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The Day graph shows the values of today and will reset at 0 o’clock. With the cursor you can move over the graph and it

shows the values at this time.

Both values for temperature and current will shown in the graph.

TODAY'S VALUES

'

{.

5

09 &

A

LY

(LY

384 oA
b W Tempeater
B Current by e o s
H'C A
=i 2§ e (i".5+ ¢ ] 226 e ol [ i)

In the 4 weeks graph use scroll wheel to zoom and drag to pan — on external display use double-touch to zoom in and use

“Reset Zoom" button to zoom back.

4 WEEKS VALUE

2 A

M

v2.10 1310 1310 1aan 110 1%=10 1510

Use scroll wheel (o zoom and drag fo pan
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The Trend value graph shows minimum, maximum and average values of the last 180 days.

TEMPERATURE LONG-TERM VALUES

5E

£

48'C

W Warsum
B svemge

Ui

I-18 ¥i-in L&D 1510 (S 1] irAn FE-10 1510

CURRENT LONG-TERM VALUES

T80 A

004

150 A

o0 A

WAL Bl manses
B Averaps

Mrimum

210 1310 Fe-1 NE-18 1E-10 1710 FE-10 1810
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5.2.16 Delete Date
You can delete the saved date of each sensor in the Sensor Assignment — the Sensor Setting will be stay.

BEBE XP IZMX16 Top_2p Inc Bottom XF 3p - Sensor Azzignement

SECTION POSITION
Thes 1% Ut assagrmebnt of (e bemperatune sensor fol

Section name: v
Sansor posidon;  Man Busbar Top /L1

Create & new Senzor Position

URRENT SENSOR ASSIGNMEN

Type: Busbar
Sarial number: 1

SENSOR SETTINGS
Comment:
Custom temperature warning ["C]: B Oelaa LSS
Custom temperature alamm ['C]:
Custom curren limit [A]; 1999.0 5| O Delwr 37500

0n this page you can assign & Sensor 1a the gren Section bus bar or creabe & new Sendor position for freely placeable sersars
The currently modfied sensor is indicabed with a red border in the graph on the right. By clcking on ancther sensor in the section graph you can perdam the
assignment for & difenent positen

Alter assigrment of a sensor the nest unassigned sensor i atomatically selecied

5.2.17 Section View
Select type of shown data with buttons.

EiT"N Sako View > Socbon Viw SYSTEM STATE: OK

Powening Bussnass Wisrdids
Ay

BEE_XP IZMX16 Top_3p_Inc_Bottom_XF_3p - Section View

SECTION POWER SECTION 1

Sade

e

Pl TS ST

Dals shoam (8 Tempersture () Cuntent

Abowe graphic shows the section Power section 1, On the feft you ses the side wew of the section and on the right the fronk view. I there are sersors squiped
behind each other, the vwew shaws all diferent 7-planes
You g chick on @ sensor o see the detads ol the Sensor assgred o the bus bar f io Sensor 1S ssgred the bnk yiekds the sensor assignment configuration

Paga
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5.3 Backup and restore configuration

5.3.1 In the "Site configuration” page it is possible to back up your complete configuration (section and Sensors).
Press “Backup Configuration” button and save the file.
SITE CONFIGURATION
Current Configuration
Site name BBB_XP_IZMX16_Top_3p_Inc_Bottom_XF_3p .
| Backup Configuration |
From file: BBB_TOP_XP_3p_XF_3p.xml

Preview picture: | Browse... No file selected.

5.3.2 To restore the site configuration click the “Browse" button to find the file. On clicking on the file will restore the
site configuration.

SITE CONFIGURATION

Current Configuration

Site name BBE_XF_IZMX1G_Top_3p_Inc_Bottom_XF_3p

" Backup Configuration
From file BEE_TOF_XP_3p_XF_3paml
Prevew picture. Browse... | No file selected.

New Configuration

Uplaad of Eaton Configurator file Browsea... | Mo file selectaed.

Restore site configuration Browse... | No file selected.

5.4 Eaton configuration preview picture

Click the “"Browse” button to find the picture (jpg), by clicking on the file will upload screenshot

SITE CONFIGURATION
Current Configuration

Site name BEB_XP_IZMX16_Top 3p_Inc_Bottom XF 3p .
| Backup Configuration |
From file: BEB_TOP_XP_3p XF_3p.xmi

Preview picture: Browse... | No file selected.

You see the preview picture; use the “Delete” button to remove the picture

SITE CONFIGURATION
Current Configuration

Site name: BBB_XP_IZMX16_Top_3p_Inc_Bottom_XF_3p
Backup Configuration |
From file: BBB_TOP_XP_3p_XF_3p.xmi

Preview picture: Delete Screenshot

e il
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55

Senor list, date backup and restore, delete sensor data

Press the Create File button to create an Excel sensor list. Press on Download to save the data. Do it in the same

way with sensor date. Restore the sensor date is similar to the configuration file.
Delete data for all sensors with Delete Data.

Sensor Data

Excel sensor list download from 2021-10-14 10:51:51 Create File

Sensor data backup download from 2021-10-14 10:51:48 Create File

Restore sensor data Browse... | No file selected.

Delete sensor data: Delete Data

5.6

Controller information, reboot, service

On Diagnose controller setting are information about the xDC, reboot the controller and send service data.

Diagnose Controller Information

CPU load 03%
RAM usage 221%
SSD system usage. 51 %
S5D data usage 0.1%

RF receivers: 1

Please reboot your Diagnose Controller after plug or unplug of an RF receiver.

Reboot Controller

Here you can trigger a reboot of the Diagnose Controller. You will only need this function in rare cases.

Service Data

You can trigger sending an email with various debug information to the configured email receipient. This email can then be forwarded to Eaton support
team for further analysis. You will only need this function in rare cases.

Send Email

5.1
5.7.1

5.7.2

Device reset

Reset Diagnose controller to factory defaults available by inserting an USB stick with a special file in root directory

named EatonDiagnoseCommands.txt with the content DoFactoryReset.
- Reset all IP settings (i.e. setting it to DHCP)

« Delete database

+ Reset password

- Reset xComfort USB interface CKOZ-00/14

Reset IP settings to DHCP

Available by inserting an USB stick with a special file in root directory named EatonDiagnoseCommands.txt with the

content ResetlpSettings.
+ Reset all IP settings (i.e. setting it to DHCP)
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6 Status box - definitions

The status box is displayed on the Site, Section and Sensor view pages in the top page areas.
The status box should be interpreted as following:

Status Box Color Interpretation
Green
i Overall System health according to mounted sensors is fine. (at least one sensor has to be active
to get “green” system state)
No Data

SYSTEM STATE: MISSING DATA

In preliminary state when no sensors are placed.

Yellow

In case of missing data at least from one allocated sensor.

- potential reasons: Sensor signal strength is too low, no signal since 5 min, Voltage drops under
3,0 Volts;

Info: required current rating at the busbar to reach 3,0 Volts:

Cross section 40x10mm / 50x10mm: 60 Amps

Cross section 60x10mm: 70 Amps

Cross section 80x10mm: 100 Amps

Cross section 120x10mm: 120 Amps

Orange

Warning: System health is close to exceeding the limits of acceptable operation. Recommended
action is detailed on the right hand side of the status box in the Site View and section View pages.
Hovering your mouse over the Status box provides the cause of state change.

Red

| SYSTEMSTATE EAMCAL

Critical: System health has exceeded the limits of acceptable operation. Recommended action
is detailed on the right hand side of the status box in the Site View and section View pages.
Hovering your mouse over the Status box provides the cause of state change.
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6.1 Using the alarm list to locate compromised areas for red and amber

To quickly determine the sensor location causing the state change that you click the Alarm icon N 6 view the
cause of the state change, text description of the sensor location and the suggested remedy. All areas causing

a state change requiring attention will be highlighted in this list. For the Section view click the alarm text in the
Section column for further details. Active alarms are represented in Red. Previous alarms not requiring any action
will be represented in green.

E:T-N

Fowwiring Busmess Workhimds
ALARMLIST
Aarm
Alarm Status Al Start Alstm End Saection Pasition Samppe st Fetedy
" . Check whather sensor is stillproperly alached. Check
2 5 50 ¥
| m :::Ilal BT ;31;;1[;1 - 331;505: 18 E;‘;E‘ 1 g’::::;;ll’ whather the sechon is sl powered (Bushar sensarn
A Chith sansor batary (xComfor)
T setectan
Ack doa selected Alams

T Show Acknowtedged Alarms

The Alarm list provides the user with text description of the compromised location. To visually identify the location and
see the specific sensor details.

1.Clicking the text in the “Section” column will navigate you to the “Section View"
2.Select a highlighted sensor location for more details

3.Carry out recommended actions

Or

1.Clicking the text in the “Position” column will navigate you to the relevant sensor

E:T-N [ semisweac
Pemiining Busnes Wb
f Ao

ALARMLIST

Mo alarms pending
P Show Acknowiedgad Alarms

ACKNOWLEDGED ALARMS
Alarm %
Rlarm Status Al St Alarim End Section Position ‘Sugpestad Remedy
S . Check whedher sensor is stillproperty atached Check whather
:‘;nal oveEr :E II,:;E‘:E! H ':I.J, 15:;1:5:'1 5 ::::?n \ ;‘:“c‘;‘::[l the eachion is =il powered (Busbar senzor) Check sensor

bakery (ol oo

Acknowledged alarms are be visible in the history view - select button.
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11
71

Modbus - definitions

Modbus-TCP register explanation
Modbus slave

The measured values and certain alarms are made available via a virtual Modbus slave (Server) over Modbus / TCP
(IEC 61158). A maximum of 3 parallel Modbus connections is possible. Port-number is 502 (as in the standard).
function/register type is 03 (read holding registers). Only 1 register can be read by one read command!

If device address scheme is used, register 0 is found at address 400001. Please be aware that 5-digits addressing
(register 0 at 40001) would not be sufficient as there are more than 9999 registers in use.

Data retrieval is done via the Modbus register address by a Modbus master (client), where the 12 MSBs are
determining the sensor-ID (which is not the serial number, written on the sensor!) and the 4 LSBs the measurand.

With the serial number (which can be read out via Modbus with the sensor-ID) the sensor can be identified in

the web interface. Sensor-1D 0 is reserved for special queries (alarms). To find out all assignments of sensor-IDs to
serial numbers, just read out all available serial numbers. If there are 100 sensors, read out following Modbus
registers: 0x001B/0x001C, 0x002B/0x002C, ..., 0x064B/0x064C.

The measurand is defined as follows:

0x0 ... Temperature

0x1l ... Temperature PCB (only busbar sensors)

0x2 ... value of electrical current ([A], as 16 Bit integer value)

0x3 ... Pending alarms for this sensor, each Bit used as a flag (see 7.1.2)
0x6 ... Section number of sensor

0x7 ... Sensor position and phase (see 7.1.3)

0x8 ... RSSI

0x9 ... Supply/Battery voltage x 10.0

OxA ... Sensor Type (0..busbar, 1l..xComfort)

O0xB ... Serial (MSBs)

0xC ... Serial (LSBs)

0xD ... Datapoint (12 LSBs) / Channel No (4 MSBs) (only xComfort sensors)
0xE ... Timestamp UTC of last transmission (MSBs)

OxF ... Timestamp UTC of last transmission (LSBs)

Example: Modbus register address 0x00AO holds the 2-Byte value of the current temperature of sensor with
ID 10. 0x00AE and Ox00AF holds the 4-Byte value of its last data timestamp.

Alarms: Register-Address 0x0000
4 MSBs ...Alarm-Code (see 7.1.2)

lowest code if multiple alarms are pending
0 if no alarm is pending

12 LSBs ...Sensor-ID, if only one Alarm on one sensor 1s pending

0 if more alarms are pending or more sensors are affected

Register-Address 0x0000 + Alarm-Code (e.g. 0x0001 for Temperature-alarm or 0x000C for Voltage-alarm)

4 MSBs ... Number of sensors affected
12 LSBs ... Sensor-ID of affected sensor (lowest ID if more Sensors are
affected)
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7.1.2. Alarm codes

71.3

In case of bit-coded alarms (pending alarms for one sensor), the LSB is Bit 0, and the MSB is Bit 15.

Example: The bit-coded alarm 0x0602 [Bit pattern 0000 0110 0000 0010] has Bit 1, Bit 9 and Bit 10 set.
According the following list, this means that this sensor has triggered a temperature alarm (Bit 1, code 0x0002),
a current warning (Bit 9, code 0x0200) and a low signal strength information (Bit 10, code 0x0400).

Alarms

Bit 0 (0x0001): LSB, Not defined
Bit 1 (0x0002): Temperature maximum reached:

o Main busbar back: T > T_max

o Main busbar top: T > T_max

o ACB/MCCB connection: T > T_max

o Dropper busbar: T > T_max
Bit 2 (0x0004): High internal sensor temperature: T_pcb > T_maxpcb
Bit 3 (0x0008): High ambient Temperature: T_amb > T_maxamb
Bit 4 (0x0010): Abnormal temperature raising, not implemented
Bit 5 (0x0020): Current higher than threshold

Warnings
Bit 6 (0x0040): Temperature threshold prewarning: T > (T_max - 10K)
Bit 9 (0x0200): Current higher than 95% of threshold current

Infos
Bit 10 (0x0400): Low sensor signal strength: RSSI value < -90dBm
Bit 11 (0x0800): Signal not received: no signal since 5min (xComfort: 12h)
Bit 12 (0x1000): Battery/Voltage too low: voltage < 3.0V

Sensor position
The sensor position is coded as follow:
Bit 0-7: Position

1. Main busbar top

2: Main busbar top double

3: Main busbar bottom

4: Main busbar bottom double
5: Main busbar roof

6: Vertical dropper busbar top
7. Vertical dropper busbar bottom
8: Horizontal dropper busbar
Bit 8-9: Phase

0:N

111

2:L.2

3:L3

Diagnose Controller Quick Installation Manual September 2022 www.eaton.com

29



F.T°-N

Powering Business Worldwide

Eaton is an intelligent power management company dedicated to
improving the quality of life and protecting the environment for people
everywhere. We are guided by our commitment to do business right,
to operate sustainably and to help our customers manage power -
today and well into the future. By capitalizing on the global growth
trends of electrification and digitalization, we're accelerating the
planet's transition to renewable energy, helping to solve the world's
most urgent power management challenges, and doing what's best
for our stakeholders and all of society.

Founded in 1911, Eaton has been listed on the NYSE for nearly a
century. We reported revenues of $19.6 billion in 2021 and serve
customers in more than 170 countries. For more information, visit
www.eaton.com. Follow us on Twitter and Linkedin.

Eaton Industries Manufacturing GmbH

Eaton.com

© 2022 Eaton Eaton is a registered trademark.
Publication No. MN145002EN

All Rights Reserved All trademarks are property
September 2022 of their respective owners.

Follow us on social media to get the
latest product and support information.



